TraceFinder Analysis Quick Reference Guide

This quick reference guide describes tasks using the Analysis mode in Thermo TraceFinder™ analytical software.

For detailed descriptions of all procedures described in this quick reference guide, refer to Chapter 8, “Using the
Analysis Mode,” in the TraceFinder User Guide.
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«» To open the Analysis mode

Click Analysis in the navigation pane.

The Analysis navigation pane opens.
Analysis -1
¥ Batch View
P Data Review

Report View

P Local Method

Batch View Use the Batch View to manually create and edit a new batch or open and edit a previously saved batch. When you
submit a batch, you can acquire data, process data, or create reports for the submitted samples.
< To open the Batch View
Click Batch View in the navigation pane.

The Batch View navigation pane opens.

Samples }

Auto Samples ——— Available only for quantitative batches when you activate
Intelligent Sequencing in the Configuration console.

Reference Sample —

Threshold Samples —— 1 Available only for quantitative batches.
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The Batch View includes the following pages:

Samples Page

Samples Page
Auto Samples Page
Reference Sample Page

Threshold Samples Page

Use the Samples page to create a new batch. Follow these procedures:

To open the Samples page

To create a batch

To add samples to the list

To insert samples into the list
To import samples into the list
To remove samples from the list
To copy a sample

To reinject a sample

To edit sample values

To create a group

To submit samples

To open the Samples page

Click Samples in the Batch View navigation pane.

To create a batch

. Choose File > New > Batch.

The Create New Batch dialog box opens.

. Select a drive from the list.

v E;"l CiTraceFinderData\32\Projects |
v [ Projectl
SubProjecth
Project2

Tip The application displays all configured and enabled repositories.

The project list displays all projects, subprojects, and batches in the selected repository.

. Select the folder where you want to store your batch.

Tip To activate the Create button, you must enter a unique batch name. If the Create button is not
activated, either you have entered a name that is already used or you have not selected a folder.

. Select either Quan or Screening from the Type list.

5. Select a master method from the Method list.

The application displays all available quantitative or screening methods.

Type: Method |Alprazaloml =

Alprazaloml

Alprazaloml

d

VitaminWater
Benzos

. Click Create.

Alprazalom1_screening
VitaminWater_screening
Benzos_screening

A new batch opens with one Specimen sample. The batch name in the title bar indicates that you are creating

either a quantitative or target screening batch.




To add samples to the list

Select the number of sample rows to add and click the Add Sample icon, =

Tip To add a single sample row, right-click the sample list and choose Add Sample from the shortcut menu.
The application adds the specified number of new samples to the end of the sample list.

To insert samples into the list

1. Select the sample above which you will insert new samples.

. Select the number of samples to insert and click the Insert Sample icon, " = i
The application inserts the Specimen samples above the selected sample.

Status  Fil Sampl G Qual Level
|n88rted atus Henarme Emp Etype rDUps Processing EVE
samples 1 & |calstd5 Calibrator [l 5

2 |: . Unknown2 | Specimen =
q . Unknownl | Specimen =
4 & |cal_std 10 Calibrator [l 10

To import samples into the list

. Click the Import Samples icon, T .

The Sample Import Tool dialog box opens.
Sample import tool El@

Import from a file (csv, xml, sld)
| Browse...

Imported samples will be: ’appended to the end of the list ']

. Click Browse and select a CSV, an XML, or an SLD file that contains the sample definitions to import.
. From the Imported Samples Will Be list, select either Appended to the End of the List or Inserted at the

Selected Row.

. Click Import.

The Sample Import Tool dialog box closes, and the application adds the specified samples to the sample list.

When you import samples from an Xcalibur™ sequence file, the TraceFinder application makes the following
column name and sample type substitutions.

Xcalibur column TraceFinder column Xcalibur sample type  TraceFinder sample type
Position Vial Position Blank Negative

Inj Vol Injection Volume Std Bracket Calibrator

Dil Factor Conversion Factor

To remove samples from the list

. Select the samples that you want to remove.

Tip Use the CTRL or SHIFT keys to select multiple samples.

. Right-click and choose Remove Selected Samples from the shortcut menu.

To copy a sample

1. Select the sample that you want to copy.

. Right-click and choose Insert Copy Sample from the shortcut menu.

The TraceFinder application inserts the copy above the selected sample.
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To reinject a sample
In the Sample list, select the sample that you want to reinject.
Right-click and choose Reinject This Sample from the shortcut menu.

The TraceFinder application creates a copy of the selected sample and appends INJ0O1 to the file name.
Additional reinjections of the same sample are numbered INJ002, INJ003, and so forth. The TraceFinder
application copies all parameter values from the original sample.

To edit sample values

. For each sample, do one of the following:

Type a new file name over the current file name.

—or—

Double-click the Filename column and locate a raw data file to use for the sample.
—of—

Right-click and choose Browse in Raw File from the shortcut menu, and then locate a raw data file to use for
the sample.

. For each sample, click the Sample Type column and select a sample type from the list.

Available sample types

Specimen Hydrolysis Solvent QC

Unextracted Calibrator Negative

. For each Calibrator or QC sample, select a level from the Level list.

The sample levels are defined in the master method. If there are no levels to select from the Level list, do the
following:

. Return to the Method Development mode.

o

. Open the method.

. Click the Compounds tab.

. Click the Calibration Levels tab.
. Add the levels.

Save the method.

o A 0

jnal

g. Return to the Analysis mode, and then click Update.

Local Method: [Method_Benzos VI |

The application updates the local method with the new sample levels.

. (Optional) Enter or edit the values for the remaining columns.

Note When you use the scroll bar at the bottom of the sample list, the Status, Filename, Sample Type,
Groups, Qual Processing, Level, Sample ID, and Sample Name columns stay fixed while the other columns
scroll right and left.

To create a group

. For each sample, click the Groups column and type the name of a group.

Note Group names are not case sensitive and are always interpreted as lowercase. For example, if you assign
one sample to “GroupA” and another sample to “groupa”, both samples are assigned to “groupa” on the

Threshold Samples page.

2. Repeat step 1 for each sample that you want to include in a group.

3. Create as many groups as you want.

Note To assign a sample to multiple groups, separate the groups with a comma.




3.

To submit samples

. Do one of the following:

* To submit all samples in the batch, click the Submit Batch icon, .
¢ To submit specific samples, select the samples and click the Submit Selected Samples icon, ¥ .

The Submit Options dialog box opens.

. Select the tasks that you want to perform: acquire data, process data, or create reports.

Note The Acquire Data and Process Data with Peak Detection options are selected by default when you
submit a batch.

To start the selected processes, click OK.

Auto Samples The Auto Samples page identifies the Solvent or Negative samples to use for any Auto Sample or Auto Sample and
Page Reinject failure actions as specified on the Intelligent Sequencing page of the method.

Oy
0‘0

. Right-click and choose Add Auto Sample from the menu, or click the Add New Auto Sample icon, *

To open the Auto Samples page
Click Auto Samples in the Batch View navigation pane.

The Auto Samples page opens.

Sample Type Injection Volume  Injections Used  Mumber of Injections  Vial Position
Solvent 1.0 0 1 |10
Matrix Blank 1.0 0 10 |11
Matrix Blank 1.0 0 10 |12

To add an auto sample type
Sl

The application adds a Solvent sample to the sample list.

You can add, insert, or remove samples from this list as you would any sample list. See “Samples Page” on page 2.

2. To change the sample type to a Negative, click the Sample Type column and select Negative from the list.

3. In the Injection Volume column for the sample, type a volume.

The minimum injection volume value allowed is 0.1 pL; the maximum injection volume value allowed is

5000 pL.

. In the Number of Injections column, type the number of injections available in the designated Solvent or

Negative vial.

After auto sample injections have occurred, you can return to this page to view the number of injections used in
each vial.

. In the Vial Position column, type the vial position for the Solvent or Negative sample.




Reference
Sample Page

Threshold
Samples Page

The Reference Samples page displays the reference samples selected for this batch.

» To specify a chromatogram reference sample
1. Click Reference Sample in the Batch View navigation pane.

An empty reference sample table opens.

Batch View - Batch_13 [Quan]
Local Method: ’Method_Eenzos vl
Barcode

Status Filename SamplelD Sample name Comment Vial position Actual

2. Right-click the table and choose Add Reference Sample from the shortcut menu, or click the Add Reference
Sample icon, ;| g,

The Open Chromatogram Reference Sample dialog box opens.

Open Chromatogram Reference Sample @
=l CATraceFinderData'32\Projects UnkniownA2 -
=+l Project A UnknownA3
U'UU Unkcnown A4
= UnknownAl -
Select a reference sample from the right panel and click "Open”. Open Cancel

Note If you are using a new method, no reference samples appear here. You must first process a batch using
the current method to see the reference samples in this list.

3. Select a project from the list of projects.
4. Select a subproject from the list of subprojects.
5. Select a batch from the list of batches.
The application displays only batches that were created using the current master method.
6. From the right panel, select a sample from the list of processed samples.

The application displays all the processed samples in the selected batch. Before using a sample as a reference
sample, you must have processed the sample with the current master method.

7. Click Open.

For each group in a batch, you can specify a sample in the group as the threshold sample to use in the Comparative
View.

< To specify a threshold sample
1. Click Threshold Samples in the Batch View navigation pane.
2. Click the Sample list for each group and choose a sample in the group to be the threshold sample.

Group Sample
» | groupb Benzo2b473 b

Benzo25557
Benzo26154

The Comparative View uses the threshold method and amount you specified in the method, the group you created
on the Samples page, and the threshold sample that you selected on this page to define the threshold guide that it
displays on the sample peak plots.

See also “To create a group” on page 4 and “Comparative View” on page 13.




Data Review Use Data Review to verify the data generated by a quantitative or target screening master method before you
generate reports.

¢ Data Review for Quantitative Methods

¢ Data Review for Target Screening Methods

< To open the Data Review view
Click Data Review in the navigation pane.

The Data Review navigation pane opens.

Data Review for quantitative methods Data Review for target screening methods
¥ Data Review > ¥ Data Review >
Sample View > Target Screening ?

Compound View
Comparative View

Qualitative View

Data Review The Data Review for quantitative methods includes these views:

. _fOI' e Sample View
Quantitative . Compound View
Methods P

¢ Comparative View
¢ Qualitative View
Sample View

The Sample View displays a list of all samples in the current batch, the compound results for all compounds in the
method, and peak plots for all compounds found in the currently selected sample.

These are the default panes and their locations.

Sample Peaks pane Samples pane Compound Results pane
Samples | ~ 1 X || Compound Results |
==} Flags Status Filename Sample Type || Flags Flag Details Compound e
i bz v ba v Aa i Aa = ba Aa - Aa -
1 " B_25557 Specimen FENTHION-CE2id
2 @ Bo261%4 Specimen Sulfisomidine  d
Sample Peaks
Peak Plot Size
FENTHION-CE20-R20-TLTE-0ED Sulfssamidine
AT 208 AT 274
A ET155904T9 AN SX991T 95
A ENT18 53 AR 13ITRR0A08
5K: 12808 SN 8888
g 100
£ mo
g L]
40
20
ol2m 2
26 a0
BT

You can display, hide, or move any of these panes. For procedures about creating docked, floating, or tabbed panes,
see “Data Review Pane Display Features” in Chapter 8 of the TraceFinder User Guide.




e Samples pane
Use the Samples pane to select a specific sample. The associated Compound Results pane displays all
compounds in the method and flags any compound with errors in the selected sample.

Samples v 1 % |[CompoundResults
=) Flags Status ~ Filename Sample Type Flags Flag Details Compound ype
W Aa v A2 v  fa = Aa v || pa Aa = Aa b

1 @ B 25557 Specimen — FENTHION-Cl und
> |2 1 . B_26154 Specimen s Sulfisomidine und

3 @ B_26473 Specimen

4 ‘ B_26984 Specimen

5 ® 8271 Specimen

Selected sample Compound error in the
selected sample

No compound error in the
selected sample

¢ Compound Results pane

Use the Compound Results pane to select a specific compound in the selected sample. The associated Sample
Peaks pane highlights the selected compound.

!!g===HE‘EEHE--------------------

g8 Flags  Flag Details Compound  Compound Type  Height Area

W 22 Aa - Aa v Aa A Aa ¥ pa v i
FENTHION-CEZ Target Compound 19889895 161840531 1
Sulfisomidine Target Compound 14929257 95285220 2

Sample Peaks
Peak Plot Size

FENTHION-CE20-R20-TLTS-QED
RT:182

8

@
=

Ralave |ntansiy

gan
i

-
=

m
=

¢ Sample Peaks pane

The Sample Peaks pane displays the chromatogram, retention time, area, height, and signal-to-noise ratio for all
compounds in the Compound Results pane. The application highlights the chromatogram for the compound
that is currently selected in the Compound Results pane.

Sample Peaks
Peak Plot Size ]

FENTHION-CE20-R20-TLT5-0ED
RT. 152

AN 15530 T8

A 15553535 0

N T
g‘mu e g‘
£ & =
{w {
= =
= 40 =

20
in 18 23




< To display details for a compound
Double-click the chromatogram in the Sample Peaks pane.
The Compound Details pane displays information about the Quan Peak, Confirming Ions, Reference Peak,
ISTD, Ion Overlay, Calibration Curve, and Spectra for the compound.
Quan Peak

You can switch between quantitative peaks, but you cannot view multiple quantitative peaks at the same time.
The indicator in the upper right corner of the Quan Peak pane displays which of the multiple quantitative peaks

you are viewing.

Peak 1 of 2
Compound Details -~ 0%
Quan Peak - E] X ||| Confirming lons - [E] E i
Propanenitrile RT: 3.17 | Unknow ‘ -} vz 7] RT: 347 | UnknownA1 RT: 317 | Unknownal
RT: 3.17 RT: 2147 RT: 3147
AA: Z3486386.17 AR 1462501521 AB: 644435370
AH: 4B23214.45 - AH: 2543776.74 > AH: 1043552 83
S SN: INF G SN: 250.15 G SN: INF
g 100 Emn gmn
£ 0 = 80 A 80
2 § 60 T 60
& 80 o @
K = 40 &40,
k2 20 20
20 o o
5. 3.0 32 34 30 32 34
a0 32 a4 RT{min} RT{min)
RT(min) m/z 281.07 mi/z 27412
m/z 300.00 42.27% - 82,27 % 281.07/309.09 = 62.27% T.44% - 47.44% 274,12/309.09 = 27 44%
ApexRT: 317 - Apex RT: 317 -
Apex RT: 317 Area: 14625018 - Area: 6444994 -
Area: 23486986
Confirming Ions
Quantitative peak with multiple confirming ions.
Compound Details > 1 x
Quan Peak - @ * ||| Confirming lons - E@ =
Propanenitrile RT: 3.17 | Unknow { = 12 L ’ RT: 3.17 | UnknownAl RT: 3.17 | UnknownAl
RT: 3.17 RT: 3.17 RT: 3.17
Ak 7248636617 AA 1462501821 Al B444553.70
AH: 4825214.43 = AH: 2543776.74 = AH: 1043533.69
= SN: INF -] SN: 250.15 -] SN INF
100 E 100 E 100
£ 50 ] 80 i 80
2] & 60 i 60
5 60 T @
g ® 40 * 45
b 20 20
204 5 B
o 3.0 32 34 30 3.2 34
30 3z 34 RT{min} RT{min)
RT{min) miz 281.07 m/z 27412
m/z 309.09 42.27% - 82.27% 281.07/309.09 = 62.27% 7.44% - 47.44% 274,12/309.09 = 27.44%
' Apex RT: 317 - Apex RT: 317 -
Apex RT: 317 Area: 14625018 - Area: 6444994 -
Area: 23436986

Note For compounds with an analog detection type, the application displays “No Confirming Ions are
Enabled” in the Confirming Ions pane.




Reference Peak

Quantitative peak with a reference peak.

M
EAE3k

Quan Peak - E @l Reference Peak -
Propanenitrile RT: 3.17 | Unknownd |i| i |L| Propanenitrile RT:0.00 | Unknownfd
RT: 3.17
AA 2348698617
= AH: 4223214 45 =
2 Sh: INF H
g 100 g 100:
2 2
E 50 % 50). RT: 0.00
@ [:3 AAD.0D
AH: 0.00
EN: INF
3 0 T T $ T T
k1) 32 EX -0.2 0.0 0.2
RT{min} RT{min}
miz: 309.09 m/z: 309.09
ApexRT:317 - Apex RT: 0.00 -
Area: 23486986 - Area: 0 -
ISTD

Quantitative peak with an internal standard.

(Juan Peak - B E[ ISTD -
Pyrazinamide RT:4.70 | Unknownal L| 1 b 1. 3-Dhoxolane, 2-heptyl- RT: 3.67 | Unknown#1
RT: 470 RT: 3.67
AA 24092396.50 AA 2B6TEE16.32
= AH: 6451154.22 = AH: 944335963
| SN: 1222.96 ‘\ SN: 153.18
100 100
E & E &
2 2
& &0 § 60
& 40 & 40
20 20
[} Oy T T T = T
4.5 4.6 4.7 4.8 4.9 35 36 a7 38 ia
RT{min} RT{min)
m/z 610.18 m/z: 464.36
Apex RT: 4.70 - Apex RT: 3.67 -
Area: 24692396 Area: 26675616 -
Ion Overlay

Quantitative peak with a confirming ion overlay.

Quan Peak - Ion Overlay =
Pyr ide RT: 4,70 | Unk 1 — —
RT: 4.70 | UnknownAd
RT: 4.70 |i| 11 | 4 | |
AA: 24652356.50
- AH: 6451154.22
E SN: 1222.36
Emn 100
g B0 'E 80
F &0 £ &0
1 E
T 40 2 40
k|
20 a2
o = o
A R A Sl A S Bl RS AT D WS A T
4.5 46 4.7 48 4.9 45 48 a7 4.8 4.9
RT{rmin} RT{min}
m/z: 610.18
Apex RT: 4.70 -
Area: 24692396 -

Note For compounds with an analog detection type, the application displays “No Data” in the Ion Overlay

pane.
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Calibration Curve

Quantitative peak with a calibration curve plot.

Quan Peak - B E[ Calibration Curve = E E f
Prapanenitrile RT: 3.17 | UnknmmA1|i| 11 |L|
= Fropanenitrile
- RT: 3.47 Average Area-1025895; % RSD 94,07
5 AR ZI4BESEE.1T
E AH: 4B2B214.48 4 |
v SN INF 3
519 15000003 -
3 E
[id E
0 E 10000003
30 32 34 E
RT{min) 500000 n
m/z: 309.09 im
-7y
Apex RT: 3.17 o Q.0 0.5 1.0 1.5 2.0
Area: 23486986 -
Spectra

Quantitative peak with data and reference spectra.

Quan Peak - Spectra - EHE -
[T y I =
Propanenitrile RT: 3.1?|UnknmmA3| 1 | n | 4 | Eyoo e
RT: 3.17 e 10
AR 2348658617 E]
= AH: 4828214.48 3 2486 24105 | 31208 4037 BEITS TeT.42 SELTS
g SN INF € 0Ttk pimie =
2.0 t T T t T T T T T
g 200 400 600 800
o B miz
2
5 60
1
& 40
=
& 309.09
20 Emn
0.
30 32 34 ¥ g 20
RT{min) k]
B 91.05 201.05 430 62375
iy e h“ 312,09 | : 851.51 987.45
' f T t + T T
200 400 600 800
Apex RT:317 o miz
Area: 23486986 -
=

Note For compounds with an analog detection type, the application displays “Not Available” in the Spectra
pane.
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Compound View

The Compound View displays a list of all compounds available in the method, all samples in the current batch, and
the peak plots for all compounds found in each sample. These are the default panes and their locations:

Sample Peaks pane Compounds pane Sample Results pane
Compounds v I x m
!
& Flag  Compound Compound =) Flags = State  Sample Name Sample Type
T 42 As b 42 - W Aa Aa Aa w: fa -
> FENTHION-CE2 Target Compound L "l @ B.5557 Specimen
Sulfisomidine  Target Compound 2 o B_26154 Specimen
3 ©® B 26473 Specimen
Sample Peaks
Peak Plot Size
B_36154 B_I6473
RT3 RT: 205
AN 16134253079 AN SETID504.18
At 13539595.40 A 1136096.68
= s ENITIEES P B ENISEET
2 £ 0] £ and e
E E a0 E a0
& ¢ ] ¢ ]
20] 203 e
1137 151 233 ] 1354
T o T a0

* Compounds pane

Use the Compounds pane to select a specific compound. The Sample Results pane displays all samples in the
batch and flags any sample that contains errors associated with the selected compound.

Compounds > I |Sampleﬁesuﬂs
!
& Fags Compound Compound Type Expected RT | 2H Flags  Flag Details Status  Filename
A2 Ae v s > v |[% e ha a2 aa v
1 !, Benzoicacid Target Compound 191 LA ! @ B 25557
2 ! | Dibutyl phth Target Compound 272 2 ® Bo6154
3— . ® B4
Selected compound Error found in the No error found in the selected
selected compound  compound in these samples
in this sample

* Sample Results pane

Use the Sample Results pane to select a compound in a specific sample. The Sample Peaks pane highlights the
selected compound and displays the name of the sample in which the compound was found and the following
information about the compound: the chromatogram, retention time, area, height, and signal-to-noise ratio.

Sample Results
g FHags  Flag Details Status Filename  Sample Type  Level Sample ID
ba - ha - fa ha - ha - Aa ha A
1 ‘ Benzo26473 Specimen SampleID013}
3 W I @  Benzo25557 Specimen SamplelD026
Sample Peaks
Peak Plot Size
Benzn26d73 BenzoZfssT
RT:132
AN 1614353079
E A 19559505.20
g 100 SN: 72555
e A0
E an.
& ap
an
0
20 . 18 20
RTimin] RT{min]
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Comparative View

The Comparative View uses three panes to display a list of all compounds available in the method, all samples in the
current batch, and the sample peak plots for all compounds found in the samples with the horizontal threshold
guide.

These are the default panes and their locations.

Sample Peaks pane Compounds pane Sample Results pane
T R R
Compounds ~ |t |[Sample Results | - 3%
B Hags Compound B Status Flags Flag Details Group Filename Sample Type Area Expected RT A
Ba Ba = Aa v fa ¥ Ba o fa v Ba - A bl A v Aa - A
1 Dibutyl phthalate ® groupb  Benzo26473  Calibrator 203323205 272 2
2 Benzoic acid, 2-[[[4-[lac{| 4 (] groupb  Benzo25557  Megative 83060018 272 2
5 [ <] groupb Benzo26154  Specimen 95285220 272 2
Sample Peaks - X
Peak Plot Size ]
Benzo26473 Dibutyl phthalate Benzo25557 Dibutyl phthalate Benzo26154 Dibutyl phthalate
RT: 2.72
AAC203323204.79
AH:99.34
b RT 2,75E RT27
1 AA: 83969917.96 AA: 05285218.89
50 AH—8. 35 AH 4312
0 : L = |. i T |T e ; % :
25 30 24 26 28 30 32 24 26 28 30 32
RT(min) RT(min) RT(min)
Benzo26473 Benzoic acid, 2-[[[4-[(acetylamino) ... 'Ben2025557' Benzoic acid, 2{[[4-[(acetylamino) Benzo26154 Benzoic acid, 2-{[[4-[(acetylamino) ...
RT: 1.92
AA 161849530.79
AH: 9983
RT. 2.06
Ak 6715690479
AH 11.64
| L |
) : 2 TN o U R o A R U EEA A -
15 20 16 18 20 22 24 16 18 20 22 24
RT(min) RT(min) RT(min)

The panes in the Comparative View are identical to the Compound View with the addition of the Group column.
This column identifies any groups that a sample belongs to, as specified in the Batch View.

The Comparative View uses the threshold method and amount that you specified in the method, the group that you
created on the Samples page, and the threshold sample that you selected on the Threshold Samples page to define
the threshold guide that it displays on the sample peak plots.

UnknownAd4 1,3-Dioxolane, 2-heptyl-

RT: 3.67
AA 26675616.33
AH: 99.75
1007 | Horizontal guide indicates
3 the threshold value as
£0] specified in the method.

|'

— = ‘_—I T
32 34 36 ia 4.0
RT{min)
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Qualitative View

The Qualitative View displays qualitative information for the selected sample. To see processed data for a sample in
the Qualitative View, you must select the Qual Processing parameter for that sample in the Batch View before you
process the batch.

These are the default panes and their locations.

Samples pane Peaks pane
Samples J v I X|[Peaks | v 1 x
@ Status = Filename Sample Type s Filter: [+ ¢ ESI Full ms [200.00-800.00] v]
s
W= fé & M- - =||E# PeakRT | & RSI MP EstAmt  Library Hit
> 1 ‘ BuspironeBl  Specimen ;7' e Al [ohd o Ba: o pa v fa -
2 @  BuspironeB2  Specimen i» 1.63 161 570 4 0.000 Sulfasomizole
Sample chromatogram - B x
Filter: + ¢ ES| Full ms [200.00-800.00] a
100
'g i)
£ w0
é 4
2 20
o T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T
1 2 3 a 5 [} T 8 a 10 1 12 13 14 15 16 17
RT{min} -
Peak details + 1 % |[Spectrum v 1 X |[Library hits
A xR 100 ww P & Rank SI RSl MP  Librarye
AH: BE45IETTE.45 ]55-"_0 140.00 | 157.00 20500 269.00 :
N 146,18 PR U Wil =l © S
2100 so 100 150 20
L © 1 332 978 0 2-Hexan
g 80 miz
F @ 2 320 966 0 Sulfisom
£ &
3 () 3 314 959 0 Propane
- 35087 43285 53683
100 = 67353
20 01 |. | I. . I I. || | L
200 400 8O0 00
0 = miz
-1 1] 1 z 3 a 5
RT{min} - -
Peak Details pane Spectrum pane Library Hits pane

Sample chromatogram pane
When you select a sample in the Samples pane, the associated Peaks pane displays all peaks found in the sample.
¢ Samples pane

Use the Samples pane to select a specific sample.

Samples - 1 Xl
|
=2 Flags Status Filename Sample Type
W = Aa Aa - 4a -
1 ®  Benzo 26474 Specimen
b2 @  Benzo 27126 Specimen
¢ DPeaks pane
The Peaks pane works with the Samples pane to display graphical values for a unique sample and peak
combination.
Peaks » 1 X
Filter: [-+ ¢ ESI Full ms [200.00-800.00] ,]
& PeakRT | SI RSI MP EstAmt Library Hit
T o v B2 fav v M v -
9.82 124 732 0 0.000 Phenomorphan
> 163 161 570 4 0.000 Sulfasomizole -
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* Sample Chromatogram pane

The Sample Chromatogram pane displays all peaks in the selected sample. The peak selected in the Peaks pane

displays a red marker.

Sample chromatogram
Filter: + ¢ ES| Full ms [200.00-800.00]
100

Relative Intensity
R - -
(=B =T = I = ]

=

~ 1 %

-

o]
=]

& 10
RT{min}

¢ DPeak Details pane
The Peak Details pane displays the selected peak.

Peak details > @ %
100 e .
- A 15333608054.13
£ ol AH: 664538778 45
5 SN 145,16
2 6o
&
7]
[:3
40
20-]
0 T T T T T T T 1 T T T T T T
E o 1 2 3 4 5
RT{min} -

* Spectrum pane

The Spectrum pane displays the reference spectrum from the library and the spectrum data for the selected

sample. The top pane displays the spectrum for

the identified compound found in the reference library; the

bottom pane displays the actual spectrum data for the selected peak.

"

Reference spectrum from
the library

Actual spectrum data for
the compound

Spectrum - 0%
Qual Library
2100+ ien
] 52.00 .00
2 5] &5.00 108.00
E -
2 ]
T 14100 lﬁ-}:} 140.00 | 157.00 205.00
(o IR N I | n I
LI LA B B B L | | LI L B S
50 100 150 200
miz
Qual Data
7 - .
2100 I, e 43225 514,88 536.53
a i 28852
2 50
b -
- S -
o e R 515.89 LT T
© 2736 |amrr |51 43383 £l
. b I — w P Y
1 TTr T T T T T T T 1
200 300 400 500 600
mz

* Library Hits pane

The Library Hits pane displays the best library matches for the selected peak. Use this pane to select a different

library entry for the peak.

Library hits - 1 x
£ Rank  SI RSI  MP  Library entry

© = = = fa A

© 1 332 978 0 2-Hexanone

© 2 320 966 0 Succinic anhydride

© 3 314 959 0 Propane, 1-(ethenyloxy)-
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Data Review
for Target
Screening
Methods

In the target screening display, the application displays a list of all samples in the current batch, the compound

results for all compounds in the method, and chromatogram and spectrum plots for all compounds found in the
currently selected sample.

These are the default panes and their locations.

Chromatogram pane

Samples pane Compounds pane Spectrum pane
Samples | ~ & % |[Compounds | - I %
4 Apple_HCDL 2 AppleFragments =
[ © Apple PosHCD_0 81 0
! @ Apple_PosHCD_0_81 0 B[ | Selected MZ RT P F LS Flag Compound Name
I @ Apple_PosHCD_4. 050 Aa v v v - v v - Aa
I M Apple_PosHCD_4. 050 -
I @ Apple_PosHCD_8 1,01 il o = = B Caffeine !
I M Apple_PosHCD_8_1.02 2 £l [ ] [ ] ®  Diethylamino
L T @ 3 ® ° ° ° ° ® disobutylphtalate
1 ] ® [ ] r 4 ] B diisobutylphtalate
2 [} [ ] [ ] ® Fi L ] M diisobutylphtalate
3 O [ ] B diisobutylphtalate  ~
 S—T— »
Chrom g « I X || Spectrum -« 1 x
M+H [ M+Na | Mk [ M+ Spectrum | @ Isotopes 100% (2 of 4) | ® Fragments (2 of 2) | @ Library (7 matches) |
Apple_PosHCD__0_81_01 diisobutylphtalate
F: FTMS {1,1} + p ESI Full lock ms [100.00-100 _.. Apple_PosHCD__0_81_01 # 1197 RT: 9.49
RT-9.49 F: FTMS {1,1} +p ESI Full lock ms [100.00-1000.00]
AR 49922290 67 279.16 :
AH: 10921681.20 100 19509 Mg
2 100 disobutylphtal
2 £ 8 ate
2 80 g 301.14
E g g 01.
> 60 =
g g4
£ 2 2 2 579.29
i 2 F “ : 31711 39128 ~ | 58130
1]} T T T T T T T | pann T . T T T T T
92 94 96 LR 200 400 600 200 1000
RT{min) miz

You can display, hide, or move any of these panes. For procedures about creating docked, floating, or tabbed panes,
see “Data Review Pane Display Features” in Chapter 8 of the TraceFinder User Guide.

Samples Pane

Use the Samples pane to select a specific sample in the batch. The associated Compounds Pane displays all
compounds in the method and flags any compound with errors in the selected sample.

Samples » 0 x
4 Apple HCD1
4 @ Apple PosHCD_0 81 01
SampleID: 1
Sample Type:Unknown
Vial Pos: CStk1-01:14
Inj Val: 125

I @ Apple_PasHCD_0_81 02
I @ Apple_PasHCD_4 05 01
I M Apple_PasHCD_4 05 02
I Apple_PosHCD_8.1.01

Flags in the Samples pane indicate one of the following:

@ A green circle when the sample/compound/peak combination is identified and fully confirmed.
A yellow triangle when the sample/compound/peak combination is identified but not fully confirmed.

@ A red square when the sample/compound/peak combination is not identified.
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Chromatogram Pane

Use the Chromatogram pane to display all extracted chromatograms of all adducts of the selected compound.

The first tab displays the most intense target adduct for the peak result. Additional (optional) tabs display extracted
ion chromatograms for other adducts for the target compound at the same retention time in order of intensity. If no
signal exists for an adduct, the first tab displays the XIC of the expected m/z within the specified retention and

chromatogram windows. When you do not specify a retention time or window, the application displays the full time
range.

Chromatogram - 1 x
M+H | M+Na | M+Na | M+NH4 |

Benzo26473 alpha-Hydroxyalprazolam-D5 NL: 8 11E6 miz: 3251165 -
F: FTMS {0,0} + p ESI Full ms [250.00-370.00]

RT: 2.60
AA 3042025991
AH: 8098519.36
100 !
50
226 235 241 246 287 292
T T T T T i T | T T T T T T T
23 24 25 26 27 238 29

RT{min)

Compounds Pane

The Compounds pane displays all found peaks in the selected sample and flags any compound with errors. The

Target Screening Results grid reflects the identified compounds found in the compound database and the results of
the method processing criteria.

Compounds v I x
8 1 Benzodiazepines Example Database
O | Selected MZ RT P A LS Flag Compound Name Match Result Name Formula
- - - - - v m v m v m -
1 ] L ] ® [ ] [ ] [ ] [ ] 2-Hydroxyethylflurazepam  2-Hydroxyethylflurazepam@RT 0.19 C17H14CIFN202
=2 | [ ] [ L L L L 2-Hydroxyethylflurazepam  2-Hydroxyethyiflurazepam@RT 142  C17HI4CIFN202
[ 1 L ] | L] ] 2-Hydroxyethylflurazepam  2-Hydroxyethylflurazepam@RT 1.71 C17H14CIFN202
B 4 ] ] [ | L [ ] 2-Hydroxyethylflurazepam  2-Hydroxyethyiflurazepam@RT 1.96 C17H1ACIFN202
@ 5 ] L] [ ® [ [ ] [ 2-Hydroxyethylflurazepam  2-Hydroxyethylflurazepam@RT 2.35 C17HI4CIFN202
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Spectrum Pane

Use the Spectrum pane to display the spectrum, isotopes, fragments, and library search information for the selected
adduct in the Chromatogram pane. The Spectrum pane displays only the identification and confirmation criteria
specified in the method. The confirmations are based only on the most intense adduct.

The Spectrum pane includes the following pages of information (when available) for each selected
sample/compound/peak combination:

* Spectrum

The application displays the neutral loss (NL) and compound/peak name information on the right side of the
Spectrum page. When data is available, the plot width is the full mass range in the raw data file. Otherwise, the
application scales the width to the scan range.

Spectrum - 1 x
Spectrum | @ Isotopes 100% (3 of 4) | ® Fragments (2 of 2) | ® Library (7 matches) |
Apple_PosHCD__0_81 01 # 1197 RT 949

F: FTMS {1,1} +p ESI Full lock ms [100.00-1000.00]

100~ 195.09 27316 NL: 1.08E7
h diischutylphtal
ate

> 807

z ]

£ 60 3.1

= ]

k]

Z 40

= ]

5

= 207 2711 57929

1.| 1711 394 28 |  581.30 73255
0 ALl L |'h T T T ey T T
200 400 600 800 1000
miz
¢ Isotopes

The isotopes page displays isotopic pattern results according to the threshold and deviation parameters defined
in the screening method. To identify or confirm the presence of a compound, the resulting score percentage from
isotopic pattern matching must be higher than the specified fit threshold percentage. An isotope peak is not
found if its intensity, relative to the monoisotopic ion’s intensity, is more than the specified intensity deviation
percentage away from the theoretical relative intensity of the isotope ion. An isotope peak is found if its
measured 72/z is less than the specified mass deviation amount away from its expected m/z.

Spectrum » 0 x
Spectrum | @ sotopes 100% (4 of 6) | @ Fragments (2 of 2) | @ Library (7 matches) |
3 Allsotopes ] Scan # 388-393 RT: 5.58-5.65 AV: 6
Benzo26473
(® Multi-lsotopes || F: FTMS {0,0} + p ESI Full ms [250.00-370.00]
*1
(@=u33011645 || sy - 33308
g 33123
| 2233111353 ] . | B2, -6
* |
. 20-] 330.30 2] | 7 =
(@#3:33011081 | 1 [P0 ss0es gy | L
(@ 2433211350 | i1
585
|W 2533212306 | k
E #4
® #6:333.11686 a2 i
| | 20~ . [ # #6
0 al T T T —T e
330 331 332 333
miz
Expected m/Z of the isotope Measured Expected
spectrum spectrum
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* Fragments

The Fragments page displays the maximum number of fragments as specified in the screening method. You must
define fragments in the screening library.

Spectrum > 0 %
| Spectrunl @ Isotopes 100% (3 of 4) | @ Fragments (2 of 4) | @ Library (7 matches) |
[a All Fragments ] Minimum # of fragments needed: 1
blank # 2124 RT. 6.09
[‘ #1:159.07149 ] F: FTMS + p ESI d Full ms2 249.02@hcd35.00 [50.00-275.00]
(@#2:18202403 | 3 1 2,
(m#313206049 | a3
(m#4:16007915 | 3 \ I
) 0 3 [ 1y _I Ll
= E | # #2.
£ 3 ; |
E E i i
E i i
5.0E4 ; ;
3 i #4 i
4#3 I = I
4= 1 i
0= T T T f T 1 T
140 150 160 170 180
miz

¢ Library

The Library page displays the matching library spectrum (in blue) and the experimental spectrum (in black).
The resulting score percentage from a library search match must be higher than your specified threshold value to
identify or confirm the presence of a compound.

The application scales both the matched library spectrum and the highest peak in the measured spectra at
100 percent intensity and displays the resulting neutral loss (NL) value for the matched library entry name to the
right of the plot.

Spectrum « 1 X
| Spectrum | @ Isotopes 100% (3 of 4) | @ Fragments (2 of 2) | ® Library (7 matches)
[ #1: Phthalic_acid_bis | *L: Phthalic_acid_bis-iso-butyl_ester C16H2204 Score:87 Rank:1of7
(8 #2: Phthalic_acid_bis-| 1:% 148.0154
[ #3: Oxadixyl 55 0
@ 24: Sulfamethazine 23 200 400 600 800 1000
[ #5: Sulfadimidin 22 Wﬂq l
[ #6: Fenthion 10 H '
@ #7: Sulfisomidin 10 10
1“":| |_ 149.0154
0= I T T T T T T T 1
200 400 600 800 1000
gl T v miz
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Report View The Report View displays example reports for the current batch. You must have an open batch to use the features in
the Report View. Follow these procedures:

* To open the Report View

* To preview a report

* To generate a report as a PDE an Excel, or a CSV file
* To print a report

¢ To display a generated report

* To edit a report template

* To create a new report template

< To open the Report View

Click Report View in the navigation pane.

The application opens the Reporting view.

Reporting - Batch_Apple_ 9705

Template Rules

“ | | Sheet Name Rules
S Baich |
Quantitation Report

Quantitation Report - 2 Sheet2 Batch
Screening Batch Report Sheet3 Batch
5G5S Report

Solvent Blank Report

Standard Addition Report

Surrogate Recovery Report

Target Screening High Density Sample Report
Target Screening Summary Report

TIC Report

TIC Summary Report b

L [_j Design ”@ New” Preview [¥] PDF ] Excel [¥] CSV [C] Print

Report generation in progress

n

Template: Sheet:
Generated Reports

Template Rule  Sample Output Generated Report File

Method Validation Report |[Batch |  |pdf | Method Validation Report_20140113092939.pdf (3 pages)
Method Validation Report  Batch s Method Validation Report_Sheetl_20140113094656.csv  View..,
Method Validation Report  Batch s Method Validation Report_Sheet2_20140113094656.csv  View..,
Method Validation Report  Batch s Method Validation Report_Sheet3_20140113094656.csv  View..,
Method Validation Report  Batch pdf Method Validation Report__20140113094656.pdf (3 pages) View...
Method Validation Report excel Method Validation Report_20140113094656.xlsx  View...

e clear

The Design, New, and Preview buttons open the Report Designer. For details about using the Report Designer,
see “Working in the Report Designer” in Chapter 8 of the TraceFinder User Guide.
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< To preview a report
1. In the Template pane, select a report template.

The template list shows all the report templates that you configured in the Configuration console.

Template

|%:| Ad Hoe Tune Report

|%| Batch Report

|| Blank Report

|| Breakdown Report

|| Calibration Report

|%5| Check Standard Report

|%| Chromatogram Report

|%:| Compound Calibration Report

|%*| Compound Calibration Report - Alternate
|%| Confirmation Report

|| Confirmation Report 2

|%|High Density Calibration Report

|%|High Density Internal Standard Report Long

2. Click Preview,
The application opens the Report Designer, showing the report information for the current batch in the selected

report template format.

< To generate a report as a PDF, an Excel, or a CSV file
1. In the Template pane, select a report template.
2. Select the check box for each of the file types that you want to create: PDE Excel, or CSV.
3. Click Generate, .
The application does the following:

* Displays a green progress bar as it generates the reports.

Report generation in progress
{Tem plate: Quantitation Report - 2 Sheet: Sheetl Sample: Apple_0_81_02

¢ Creates a report with the selected report template as a PDE an Excel, or a CSV file.

¢ Adds information about the generated report to the Generated Reports pane.

e Saves the report files to the ...\TraceFinderData\32\Projects\batch\ReportOutput folder.
< To print a report
1. In the Template pane, select a report template.

2. Select the check box for the Print file format.

3. Click Generate, .

The application does the following:
¢ Creates a report for the current batch using the selected report template format.
e Prints the report to your default printer.
* Adds information about the generated report to the Generated Reports pane.

¢ Saves the report files to the ...\TraceFinderData\32\Projects\batch\ReportOutput folder.

< To display a generated report
In the Generated Reports pane, click View for the report that you want to see.

Generated Reports

Template Rule  Sample Output Generated Report File
Method Validation Report  Batch pdf Method Validation Report_ 20140113092939.pdf (3 pages) View..

Opens the
generated file.
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Local Method
View

< To edit a report template
1. In the Template pane, select a report template.

2. Click Design, .

The application opens the Report Designer showing the template in an Excel spreadsheet.

« Report Designer - Batch Report.xlsx
m Home Insert Page Layout
T O = _ [T =1 o e
B =2 calibri -la -|A A = = |= | SiwmpTen = e i ij ﬁ
Paste B 7 U Sy A = |rad Merge Cells Insert Delete Format Conditional Show
= H — - ;3 L - - - Formatting  Formulas
Clipboard Font i Alignment il Cells
Report Type: Batch | D57 -
A B [o D E F G
1 Batch Report
2
3 |Lab Name: "Default Laboratory
4 instrument: FThermo Scientific Instrument
2 |Usen: Fana powers
6 |Batch: Batch_Apple_9705
7
8 [File Name Date/Time Sample ID Sample Name
9 |Apple 0 81 01 72010 12:47:10 AM 1
10 |Apple_0_81_02 7132010 1:03:40 AM 1
11 |Apple_0_81_03 7132010 4:37.50 AM 1
12

3. Use the features in the Report Designer to edit the template.

< To create a new report template
1. Click New, [ New ],
The application opens the Report Designer showing an empty template in an Excel spreadsheet.

2. Use the features in the Report Designer to create the template.

In the Local Method view of the Analysis mode, you can edit only the local copy of the method, or you can edit the
master method and overwrite the local copy with the edited master method. A local method is a copy of a master
method associated with a batch. Editing the local method does not affect parameters in the master method.

K2

«» To open the Local Method view
Click Local Method in the Analysis navigation pane.

The Acquisition page of the Local Method View opens. The Acquisition pages are different for quantitation
methods and target screening methods. See Local Method View of a quantitation method or Local Method View
of a screening method.

From the Local Method view, access the method parameters just as you would for a master method.

Local methods are named BatchName_MasterMethodName.

+ To edit a local method
1. Enter any changes to the local method.

To edit a method, refer to the method development chapters in the TraceFinder User Guide.
2. Choose File > Save.
3. To process the batch or create new reports with the edited local method, return to the Batch View and submit

the batch.

< To overwrite the local method with the master method in the Batch View

In the Batch View, click Update.
- |

The application overwrites the local method with the master method of the same name. You can use this feature
to overwrite an edited local method with the original master method or to overwrite the local method with an
updated master method.

Local Method: | Method_Vitaminl
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Figure 1. Local Method View of a quantitation method

Analysis + 1 | Local Method View - Equanl_408 Method Equan 1*
»  Batch View Master method: Method Equan 1
» Data Review Lab Mame: Default Laboratory
Assa e Aszay name
Report View L
Injection Volume: 1,100.00 =1
¥ Local Method > =
Mass Precision: 3.00 —
[ Mcipndvon ] Ion range calc method: [LE'\-"E| ']
Quantitation
Use level: [ ']
Processing
Instrument Method: | Pesticides Using EQuan ~ | [ Edit l Update
Compounds
Notes
QAQC
Groups
Intel Seq
Reports

Figure 2. Local Method View of a screening method

Local Method View - Batch_1_Method_Screening_Alprazolam

¥ Batch View Master method: Method Screening Alprazolam
Samples Lab Mame: Default Laboratory
¥ Data Review Assay type:  Assay name
; Injection Volume: 100 2
Target Screening J : =
Report View Mass Precision: 200 %
¥ Local Method >
Instrument Method: | Pesticides Using EQuan - | [ Edit l Update
[ Acquisition l Motes
Screening
Processing
Peak Detection
Reports

Trademarks TraceFinder is a trademark and Xcalibur is a registered trademark of Thermo Fisher Scientific Inc. in the
United States.

Excel and Microsoft are registered trademarks of Microsoft Corporation in the United States and other countries.
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